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LOLO２/ALTI2 高度記録計操作マニュアル 
 
1 はじめに 

LOLO2(Lomcovak Logger)デジタル高度記録計をお買い上げいただき、ありがとうございま
す。LOLO は模型飛行機やロケット用に設計されています。LOLO2(別名 ALTI2)は、従来の
LOLO の機能を飛躍的に向上させたものです。従来の LOLO 同様、みなさんのラジコンライフ
を楽しくしてくれるものと思います。 

 
2 何に使えるか 

LOLOは、模型飛行機、ヘリコプター、あるいはロケットの高度をリアルタイムに測定し、記
録できるよう設計されています。もちろん、模型飛行船、自転車競技、ハイキングといった他の

用途に応用することもできます。高度計は、模型飛行機の高度あるいは動きを読みとって記録で

きます。現在高度は、ユーザが選んだサンプリングレートに従ってメモリに記憶されます（サン

プリングレートの項を参照）。最大記録容量は、サンプリングレートが 1 秒に１回の場合、２時
間１６分まで記録できます。装置内のメモリには、電源スイッチを ONにするたび毎に、自動的
に１つの記録データが作成され、メモリ容量の範囲で、幾つでも独立した記録データとすること

ができます。各記録データセットのデータ長、記録期間、高度データ（高度 0mに気圧）は、他
の記録データとは、独立しています。例えば、１つの記録データには、その日の全てのフライト

を、別のデータには、家までの帰路の高度履歴を記録することができます。ノート PCがあれば、
その場で、あるいは家に戻った後、LOLOの記録データセットを PCにダウンロードすることが
できます。 

 
3 技術仕様 

仕様 
項目 

LOLO2 Standard LOLO2 B&F(Big & Fat) 
寸法   35x10x18mm (Standard)  
重量  8g  
サ ン プ リ ン グ レ ー ト

  
0.１sec (14min) 
0.2sec (28min) 
0.5sec (1h8min) 
1.0sec (2h16min) 
 

- 0.1sec (54min) 
- 0.2sec (1h49min) 
- 0.5sec (4h32min) 
- 1.0sec (9h4min) 
- 2.0sec (18h8min) 
- 6.0sec (54h24min). 

最大メモリ容量  8400 points 32640ponits 
セッション数(ON/OFF) メモリを使いきるまで増やせる。 
電源  4.4-9.6V (DC) 
定格電流  15mA 
計測精度  0.5m(1.64ft) 
計測限界高度  2000m(6562ft) 
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4 製品キットに含まれるもの 
 
製品には以下のものが含まれます。 
・LOLO2/ALTI2高度記録モジュール：１個 
・PCインタフェース：１個 
・LOLOware (専用ソフトウエア)（１ライセンス）の CD 

Lomcovak site: http://www.lomcovak.cz/eindex.html 
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5 高度記録計の組込みと操作 
 
(1) 高度記録計の組込み 

LOLO2は、胴体などの空きスペースがあるところならどこでも設置できます。高電圧線に近
い所に設置しないよう注意が必要です。LOLO2の配線は、サーボのインストールと同じように、
高度計の電源コネクタを、受信機の開いているチャネルに差込みます。このようにすると受信

機の電源を ONするのと同時に高度計の電源も ONになります。模型ロケットやラジコン以外
のもので使う場合は、単純に高度計と適当な電源（4.4-9.6VDC）につなぐだけです。電源のス
イッチを入れた時点で高度計が使える状態になります。このような場合、電源と高度計の間に

スイッチを入れることをお薦めします。電源ケーブルを抜き差しするのはお薦めできません。 
電源を入れる前に高度計本体に付属しているディップスイッチで、サンプリングレートを選

ぶ必要があります。（下図参照）サンプリングレートの初期化は、電源 ONの時のみに行われま
すので、サンプリングレート変更をしたい場合は、一端電源を OFFにするか電源コネクタを引
き抜いてください。 

上図に示されるように Standard LOLO2では、ディップスイッチの位置により４つのサン
プリングレートを選択することができます。 

  
(2)  測定操作（LOLO Raceの場合） 

LOLO Raceは、次の２つのモードで動作させることができます。 
表 LOLO2の動作モード 

プロポ制御モー

ド 
このモードではプロポを使用し、プロポ（任意のチャネル、あるいはスイ

ッチ）から、スティック、スイッチ、ボリューム等のいずれかの操作によ

り高度記録を開始・停止することができます。ただし、一度、停止した後

は、電源 OFF/ONを行わないと記録を開始できません。 
独立モード このモードでは、120秒の初期化後、自動的に高度記録を開始します。120

秒の初期化をバイパスすることはできません。 
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(3) プロポ制御モード 
このモードでは、高度計は、受信機のどれかのチャネルに接続されていなくてはなりません。

そのチャネルに関連づけたスイッチにより、記録の開始及び停止ができます。 
受信機のスイッチが ONにされると、高度計本体の LEDは、受信機チャネルの状態を表示
します。すなわち、LEDが点滅していれば、チャネルはMINポジションにあり、LEDが点灯
（つきっぱなし）であれば、チャネルは、MAXポジションにあります。高度記録を開始したい
場合は、プロポのコントローラ（スティック、スイッチ、電位計）を用いて少なくともチャネ

ルの状態を少なくとも、１秒間MIN-MAX-MINあるいはMAN-MINポジションというように
変化させる必要があります。以上をまとめると下表のようになります。 

 
表 プロポによる記録開始操作 

電源 ON時の状態 操作 LOLOの LEDの状態 
1) 初期状態） ゆっくり点滅 
2) MINからMAXポジションにす
る。少なくとも１秒間待つ。 

点灯 
MINポジション 
（MIN-MAX-MIN操作） 
 

3) MAXからMINポジションにす
る。 

サンプリングレートで点滅 
記録が開始される。 

1) 初期状態 点灯 MAXポジション 
（MAX-MIN操作） 2) MAXポジションからMINポジ

シ 
サンプリングレートで点滅 
記録が開始される。 

 
記録を開始すると LOLOの LEDは、サンプリングレートの間隔で点滅を開始します。これ
はサンプリングレートを目視で確認するためです。 
上表でわかるように、LOLOの記録が開始されると LOLO制御用のスイッチ、またはボリュ
ームは、MINポジションになります。したがって停止はする場合は、操作は１種類で単純に下
表のようになります。 

表 プロポによる記録停止操作 

記録停止操作の初期状態 操作 LOLOの LEDの状態 
1) 初期状態） サンプリングレートで点滅 MINポジション 

（MIN-MAX-MIN操作） 
 

2) MINからMAXポジションにす
る。少なくとも１秒間待つ。 

点灯 
記録が停止される。 

 
具体的に例を示します。例えば、LOLO2を８チャンネルに接続した場合、フタバの FF８等
では、８チャネルの制御にはボリュームで行います。LOLOは受信機のチャネル８に差し込み
ます。ボリュームが電源投入時、MAXポジションにあれば、LOLOは点灯状態となります。
この状態から、記録を開始するには、一端、MINにすれば、記録を開始し、サンプリングレー
トの間隔で点滅します。またその後、MAXにすれば、記録は停止し、点灯状態となります。 
ボリュームが電源投入時、MAXポジションにあれば、LOLOは、ゆっくり点滅します。こ
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の状態から記録を開始するには、一端、ボリュームをMAXポジションにします。すると LOLO
は先に説明したような点灯状態となります。次にボリュームをMINポジションに変更すれば、
LOLOは記録を開始し、その状態ではボリュームはMINポジションにあります。記録を停止
するには、MAXポジションにすればよいわけです。 

 
(4) 独立モード  
このモードでは、電源 ON/OFF操作のみで、記録の開始停止を行います。（このモードはト
レッキングに使用する場合には必要です。）高度計をこのモードで動作させるためには、必要な

条件が１つあります。受信機と接続されている３本のコードの内、オレンジのコードをコネク

タから外して受信機につなぐ必要があります。針があれば、コネクタの黒いケースからピンを

外すことができます。また外したコードはテープかヒシチューブで絶縁しておくことをお薦め

します。もし、プロポ制御モードでは絶対に使用しない場合にはオレンジのコードを切断して

も結構です。また、受信機に接続せず、電池にのみ接続する場合は、何もせず、そのままつな

げば結構です。 
POSTモードの後、LEDは、１秒点灯、１秒消灯を繰り返します。これは、初期化段階で、
高度計が、周囲の環境（温度、圧力など）に合わせられるようにするためのものです。この段

階は 120秒に固定されておりスキップすることはできません。競技で使用される場合、発航の
前に少なくとも２分間かかることを覚えておいてください。高度計が、高度を記録している間、

高度計の LEDは、ディップスイッチで選択されたサンプリングレートで点滅します。 
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6 LOLOWare（専用ソフトウエア）のインストール 
LOLO２には、従来の Excelマクロではなく、高速の読み込みが可能で、使い易いユーザイン
タフェースの専用ソフトウエアが付属しています。（ここでは LOLOWare と呼びます。正式名
称は、未定です。） 
まず、付属の CDを PCに挿入してください。 

 

PC に必要なファイルをインストールするため、CD に含まれている”setup.exe”を実行（上の
アイコンをダブルクリック）します。すると次の画面が表示されますので、大文字小文字に注意

してパスワードを入力し、Nextをクリックしてください。 

 
「ライセンス契約を承諾する（I agree・・・）」を選択し Nextをクリックします。 
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次に、インストール先を選択し、Nextをクリックします。 

 
 
以下の画面が表示されインストールが終了します。 
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7 LOLOWareの操作方法 
Windowsのスタートメニューから、プログラム＞ALTi>Altitude Loggerと選択し、プログラ
ム起動します。すると下図のウインドウになります。 

 
図 初期画面 

(1) 設定 
初期画面のメニューから“Data”をクリックし、プルダウンメニューで”Setting”をクリック
すると以下の画面になります。 

 

図 Setting画面 

このメニューで、ポート番号を確認します。デフォールトは、COM1ですが、USB-RS232C
コンバータを使用する場合には、この“Port“番号を変更しなければならないことがあります。
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また、RS232Cシリアルインタフェースのポート設定を変更する必要がある場合は、”Setup”
ボタンをクリックし、設定します。同ウインドウ下部の圧力から高度を計算するための計算式

は、基本的に変更する必要はありません。ただし、LOLO/Race以前の高度記録計で記録したデ
ータを本体メモリから読み込む場合には、変更が必要です。この式は、各フライトデータ毎に

設定できます。（７章(3) c.を参照） 
 

 
図 シリアルインタフェース設定画面 

（注）通信パラメータを 19,200bps、順番に”8”、”なし”、”1”、”なし”と設定する（これら
の値はプリセットされているので変更しないこと。変更すると通信ができなくなり

ます。）残りの通信パラメータも修正する必要はありません。 
 
LOLO/Race のデータを本ソフトウエアで読み込む場合の計算式 

 

○LOLO/Race のデータを本ソフトウエアで読み込む場合の計算式 

 

Data>Setting の画面の Pressure の計算式： 101.50505-X/81.1008 

 

（注：この式は、寺田篤生さんが LOLO/Race と LOLO2 を同時に搭載し、実測により近似式

を求めたものです。） 

 
Pressureの計算式を変更するには、メニューバーから、Data＞Setting>＞pressureの左の
「…」のボタンを押下し、次の画面で式を入力し、ADDボタンを押します。 
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図 計算式の登録画面 

 
(2) データの読込み 
まず、高度計の電源を切り、インタフェースコードを PCのシリアルポートに接続します。
プラグは極性を間違えて接続しないようになっているので、一通りの方法でのみ差し込めます。

USBポートしかない場合は、USB-RS232Cコンバータを別途購入してください。 

 
図 データ読み込み用シリアルインタフェースケーブルとの接続 
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図 USB-RS232C コンバータとシリアルインタフェースケーブルの接続 

（ELECOM社、アイオーデータ社の製品は動作確認済み） 

 
初期画面のメニューバーから”Data”をクリックし、プルダウンメニューの中の”Read Data”
をクリックすると以下のウインドウが出て、データ入力待ち状態となります。 

 

図 データ読み込み画面 
このウィンドウが表示されたのを確認し、LOLOの電源を ONにします。（従来の Excelマ
クロのように、バイアス値をセットする画面は表示されずにいきなり入力状態となります。）す

ると、ただちにデータが読み込まれます。データ読み込みが完了すると下図の左端に、データ

名が表示されます。 
この時点で、LOLOの電源は OFFにして構いません。 
LOLOWareでは、１回に読み込まれるデータをモジュールと呼びます。モジュールは、１回
の読み込みで読み込まれたデータ全体で１つです。LOLOを初期化し他のデータを入力される
と前回のモジュールに加え、新しいモジュールが作成されます。１回分のデータに複数のセッ

ション（１つのセッションは、電源ONからOFFまでに記録されたデータブロックを指します。）
がある場合、１つのモジュールの中の複数のブロックとなります。下図のモジュールのプラス

アイコンをクリックするとブロックが表示されます。ブロックをモジュールとして扱いたい場

合は、読み込みメニューで”Put each data block to separate Module”をチェックしておきます。 
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(3) フライトデータの情報とフライトデータの整理のための機能 
 
a. Session と Module 

データを読み込むと下図の画面になります。左の枠にあるツリー状の図の最上位はセッション

となり、その下にあるアイコンがモジュールになります。先に説明したようにモジュールが、個々

のフライトのデータに対応します。 
矢印２で示される欄には、各モジュールの情報が表示されます。この情報はフライトデータ毎

についています。このフライトの高度測定に、LOLO/Raceを使用した場合は、計算式が LOLO2
とは違いますので、”Calculation “ボタンを押して、計算式を変更し、調整します。LOLO/Race
用計算式は、「本書７章(1)設定」を参照してください。 

 
図 Session とModuleの管理画面 

b. セッションの情報メモ 

上図の矢印３で示される欄には、何でも自由に記入できます。この欄には、チームメイトと後

で議論する時に、何のデータであったかを記録しておくと便利です。このメモは、Session毎に
書くことができます。通常は、session をパイロットの名前とし、各 TaskA,B,C のデータが
Muduleになりますので、パイロット毎に分類する方法が一般的です。 

 
c. フライトデータの分類 

上図の左欄を用いるとフライトデータを効果的に分類することができます。予めメニューバ

ーから Data > Insert empty sessionを選択し、Empty Sessionを選択し、Sessionを人数分
作成しておき読み込んだデータ（Module)を Drag&Dropで各パイロット（Session)に分類すれ
ば、パイロット毎の記録を１つのセッションとしてまとめることができます。 

12 
 



All copyright reserved by partnership RC-Sailplane.com 

(4) グラフの表示 
データ読み込みが完了した段階ではグラフは見えませんので、メニューバーから View＞

Graph Viewと選択します。すると下図のようなグラフが見えるようになります。下図右下に
“Info”と“Graph”というタブがありますので、この Graphタブをクリックしても同様にグ
ラフ画面に移ることができます。 

 
図 データ読込み後の画面 

13 
 



All copyright reserved by partnership RC-Sailplane.com 

(5) グラフの操作（全般） 
LOLOWareは、強力なグラフ操作機能があります。 

 
図 グラフ操作機能 

 

表示するグラフの選択は、上図左上のモジュールの中にあるブロックを選択することで行い

ます。ブロックの前にあるチェックボックスをマークすると、選択されたブロックが重ね合わ

され、常に表示されます。さらに表示したいブロックをクリックするとそのグラフも重ね合わ

されて表示されます。 
 
(6) グラフの拡大縮小 
上図メニューバーの４種類の虫眼鏡アイコンがあります。これを使ってグラフの任意の場所

を拡大・縮小できます。 
a. Horizontal Zoom in （横方向のみの拡大表示） 

Horizontal Zoom inのアイコンをクリックします。次にカーソルを拡大表示したい範囲の
左におき、マウスの左ボタンを押しながら、範囲を設定すると横方向のみに拡大された表示

に変わります。 
 
b. Horiz. & Verti. Zoom in (四角で囲んだ範囲の拡大表示) 

Horiz. & Verti. Zoom inのアイコンをクリックします。次にカーソルを拡大表示したい範
囲の左上におき、マウスの左ボタンを押しながら、拡大表示したい範囲を設定すると、四角

形に囲まれた領域が、縦横方向に拡大された表示に変わります。 
 
c. Zoom out （縮小表示） 
上記の拡大表示操作を１つ戻し表示範囲を拡げます。 
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d. All data （全体表示） 
データ全体を表示します。上記の拡大・縮小表示を解除し、全体画面になります。 

 
(7) 計測データの２点間の高度差（デルタ値） 

LOLOWareは、グラフの任意の２点間の高度差、時間差を簡単に表示し、クリップボードに
転送することで速度計算等に利用できます。 

 
a. Toggle graph Zoom/Measurement(計測データのデルタ数値表示) 
まず、Toggle graph Zoom/Measurementボタンをおすとデータ点を取得するモードにな
り”Graph Measurement” ウィンドウが表示されます。この後、グラフの任意の点にカーソ
ルをおき、クリックし始点を決め、マウスの左ボタンをクリックしたまま、終点まで移動し、

そこでマウスの左ボタンを離すと、その２点の座標 (時刻、高度 )が、上図の”Graph 
Measurement” ウィンドウ上に表示します。この値は”Copy to Clipboard”ボタンをおすと
クリップボードにテキストデータとしてコピーされます。 

 
(8) データのインポート、エクスポート 

LOLOWareのデータは、LOLOフォーマット(*.llo)あるいは、テキストデータに出力したり、
他の人の LOLOデータやテキストデータを読み込むことができます。 

 
a. データのインポート 
初期画面のメニューバーから、File>Importと選択すると、”Alti Data File”か”Raw Text 

File”を選択することができます。前者は、LOLO2で作成したデータ（モジュール単位）を
読み込むための機能で、後者は、テキストファイルをインポートするための機能です。 

 
図 データのインポート画面 

 

b. データのエクスポート 
初期画面のメニューバーから、File>Export Selectedと選択すると、”Translated data to 

Text”と”Raw data to text”が選択できます。前者は、LOLOWareで読み込んだ加工したデ

15 
 



All copyright reserved by partnership RC-Sailplane.com 

ータをテキストファイルに出力します。後者は、LOLOのオリジナルデータをテキストファ
イルに出力します。 

 
図 データのエクスポート画面 

(9) グラフ表示方法の変更 
LOLOWareは、グラフ上に、Launch点、最高高度点、A面、B面などのマーカとその説明
を付加して記録として残すための強力な機能があります。フライヤーでなければ、このような

機能の必要性はわからないものです。その他グラフの色、軸の表示、フォントの変更などが可

能です。 
 

a. グラフの編集 
(a) グラフ属性全般 
グラフの表示エリアの中の方眼紙の部分をダブルクリックすると以下の画面が表示さ

れます。デフォールトは、”General”タブが選択された状態で表示されます。Main Title, 
Sub Title, カラー表示、フォントサイズ、軸表示（軸をグラフの前に表示することも可
能）、軸の数値表示精度などを変更できます。 

 
図 グラフのカスタマイズ 
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(b) プロットグラフの変更 

Plot タブを選択すると、グラフ表示を線にしたり、点にしたりすることができます。
また、データ点すべてをマーク表示も可能です。 

 
図 グラフ種類の変更 

 
全画面表示：Maximizeボタンで、全画面表示することができます。 

 
さらに右下の Exportボタンをクリックすると下図のウインドウが表示され、グラフを
イメージデータとして出力することも可能です。 

 
図 グラフをイメージデータとして出力 
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(c) 軸の編集 
Axisタブにより、軸の属性を変更することができます。軸の最高値、最低値なども変
更できます。 

 
 

図 グラフの軸の変更 

 
(d) フォントの変更 

Fontタブにより、グラフ中のフォントを変更することができます。 

 
図 グラフ中フォントの変更 
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(e) カラーの変更 
Colorタブにより、ワークエリアの色を変更することができます。 

 
図 グラフカラーの変更 

 

(f) プロットスタイルの変更 
Styleタブにより、データ点のマーク、色を変更できます。 

 
図 プロットスタイルの変更 
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(10) イベント点、フライトの Annotation（説明）の編集 
LOLOWareでは、任意のプロット点にマーカと呼ばれる目印を描画し、それに説明を加える
ことができます。例えば、グラフの各点に Launch、Top、A-side, B-side、Landingなどの説
明や、TaskC No.1等の説明を付加すれば、記録としての価値を高まります。尚、漢字等日本語
の Annotationは使用できません。 

 
a マーカの追加 

マーカというのは、プロットされたグラフの目印を言いますが、これは、グラフ内の任意

の点に入れられます。このマーカの座標は、（時刻、高度）であってグラフ上の画面座標では

ないところが、有用さの理由になっています。 
次頁にマーカの追加方法を図示しまします。まず、赤い数字１で示される Toggle graphボ
タンをクリックし、Graph Measurement ウィンドウを表示します。次にマーカをおきたい
グラフ内の任意の場所にカーソルを移動し、マウスを右クリックし、その座標が、Graph 
Measurementウィンドウに表示されたのを確認します。次にマウスを右クリックし、そのプ
ルダウンメニューから、”Edit Annotation”を選択すると次頁の赤い数字２で示される”Data 
Block Annotation”ウィンドウが表示されます。このウインドウの右にある”add”ボタンをク
リックすると ”Edit Annotation”ウインドウが表示されますので、これに、Graph 
Measurement に表示されている座標を赤い数字４で示されているところに手で打ち込みま
す。（クリップボードを介してペーストすることもできますが、写した方が速い。このあたり

の操作は改善の余地があります。）さらに適当なコメントをつけ、マーカの形などを選択して、

赤い数字の５の OK ボタンをおすと、赤い数字６の位置にマーカが表示されます。例では、
青い三角マークに Added Makerというマーカが表示されています。 
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図 マーカの編集 
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このマーカを使うと味気ないグラフが、魅力的な記録に変わります。これなら仲間内に見

せ自慢することもできます。 
 
（注）マーカ追加には、次節で説明するオフセットを設定する前に行う必要があります。

マーカの座標はオフセットなしのオリジナルデータでないとうまく追加できません。

これはバグと思われますので、次のバージョンで改善されることと思います。 
 
b プロットグラフのオフセット変更 

グラフを表示すると計測開始時刻が０として表示されますが、発航時点を０にしたり、あ

るいは、A面を０にしたりして見やすくすることができます。また、高度についても計測精
度が０．５ｍですので身長などにより発航時点の高度が０でないこともあります。このよう

な場合、Offsetを指定することで、グラフの目盛りをシフトすることができます。 
下図では、発航時点がー32秒になっています。（この例では、元データが既に変更されて
いるのでマイナスの時刻が表示されています。）これを 32 秒シフトするには、画面左下の
Offsetをクリックし、+32秒を入力します。その後、グラフ内の任意の点をクリックすれば、
目盛りがオフセット表示され、シフトされます。Offsetを入力する場合は、画面左下の SEC
をマークした方が容易です。 

 

図 グラフオフセットの変更 

 

原点指定によるオフセットの設定 
上記のようにオフセット値を入力してシフトするのでなく、マウスで指定した点が原点 

(0sec，0m)となるようにシフトすることができます。 
画面上で原点としたい場所にカーソルをセットし、右クリックし、”Apply Offset Set[0,0]”
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をするとその場所が原点となるようにシフトされます。 
このオフセット機能を使用すると、複数のグラフを、下図のように容易に重ね合わせて表示

することができます。 

 

図 原点を指定してオフセットを設定する 

 
Offsetの解除 
上記で設定した Offsetをすべて解除するには、グラフ上の任意の点で右クリックし、プルダ
ウンメニューから、Reset all offsetsを選択すれば、解除されます。 
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8 メモリの消去 
 
高度計のメモリから全てのデータを消去するには、以下のステップを実行します。まず、高度

計の電源が OFFとなっていることを確認する。 
PCインタフェースケーブルを高度計に接続する。（PCには接続していなくてもよい。） 

 
図 メモリ内データの消去、初期化 

 
PCインタフェースケーブル上にあるリセットボタンを押下したまま、高度計の電源を ONに
する。 
最初は LED が点灯するが、メモリ上のデータが完全に消去されると、高度計の LED が急速
に点滅する。 

メモリ消去時のLED表示

電源ONRST押下 LED点滅開始＝メモリ消去完了

時間

高度計の電源をいれる前
に、RSTボタンを押下したま
まにする。

 
図 メモリ内データの消去の流れ 

高度計の電源を切り、インタフェースケーブルを外す。この後、高度計の電源を入れると、再び利

用することが可能な状態になります。 
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9  サンプリングレートの変更（品質保証対象外） 
 
登山、ロードレースなどのようなアウトドアスポーツで使う場合、長いサンプリング間隔が、

必要になる場合があります。このような時は下図の黄色の矢印で示される２点を半田付けするこ

とで、４つのサンプリングレート全てを倍の長さ(0.2, 1.0, 2.0, 6.0秒)にすることでができます。 
ただし、長時間の半田付けにより部品が破損した場合、あるいはサンプリングレートが２倍に

ならない場合も、補償はできませんので予めご承知おきください。 
 

 

図 ハードウエアの改造によるサンプリングレートの変更 
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10  注意事項と補償について 
高度計は、高電圧ケーブルからできる限り離して組み込んでください。 
電圧スパイク変動は、高度計の高度測定に影響を与えることがあります、また、他とインタフ

ェースのない独立な電源から給電される場合のみ、高度計の適切な動作が保証されます。もし模

型の電源が適切でない場合は、独立した電源をお使いください。電源には、110mah、4.8Vのパ
ックが適当です。 

 

 

○ 販売及びサービス 
Ing. Roman Vojt.ch   
U Studánky 31   
Prague 170 00   
Czech Republic   
e-mail: info@lomcovak.cz,    
website: http://www.lomcovak.cz/eindex.html

 
○ 日本販売代理店 
  ・合資会社 RC-Sailplane.com 

Tel/Fax: 042(332)5179 
http://rc-sailplane.com 
mailto://info@rc-sailplane.com 

  ・Aircraft 
Tel/Fax: 0948(21)1040 
http://aircraft-japan.com/ 
mailto://shop@aircraftjapan.com 
 

○ 改訂 
- version 0.5 2003年 5月 11日 
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